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Infroduction

OSP Real Estate is a versatile Responsive Joomla template for Real Estate Welbsites and
supports both Joomla 3.x & Joomla 2.5.

OSP Real Estate also supports RTL Language Layouts and especially it is designed to
use with OS Property extension.

With no exception, OSP Real estate is built on the powerful T3 Framework making it a
fully responsive Joomla template at default, having all the great features T3
Framework has including ThemeMagic and Layout Configuration tool.

OSP Real Estate comes in 6 color schemes.

Responsive Joomla template for Joomla 2.5 and Joomla 3.x. We have written this the

documentation based on Joomla 3.x, please do consider this factor if you are using it
for Joomla 2.5.x. No worry, there aren't any big differences between the two.

",-r Cs5 HTML

Field name

Clean & Modern Design

Responsive HTMLS + CSS3 Design

Bootstrap 3 Integration

Cross-browser compatible

Easy to customize

Using T3 Framework



CREDITS:
[Query — jQuery JavaScript Library (http://jquery.com/)
HTMLS Shiv (http://code.google.com/p/htmi&shiv/)

Twitter Bootstrap — Bootstrap Framework (http://twitter.github.io/bootstrap/)

CSs:

Twitter Bootstrap — Bootstrap Framework (http://twitter.github.io/bootstrap/)

COMPATIBLE BROWSERS:

CREATED: 22th July 2014

SOFTWARE VERSION: OS Property 2.7.3


http://jquery.com/
http://code.google.com/p/html5shiv/
http://twitter.github.io/bootstrap/
http://twitter.github.io/bootstrap/

Requirements

Software: PHP (Magic Quotes GPC off): 5.3.1 + (5.4+ recommended)

Databases

MySQL(InnoDB support required): 5.1+
MSSQL 10.50.1600.1+

PostgreSQL 8.3.18+

Web Severs

Apache 2.x+

Microsoft IIS 7

Nginx 1.0 (1.1 recommended)

Joomla 2.5+ system requirement Software
Software: PHP 5.2.4+ (5.4+ recommended)
MySQL: 5.0.4+

Web Sever

Apache: 2.x+

Microsoft: IS 7

Nginx: 1.0 (1.1 recommended)

Browser requirement

The requirements are the same for both Joomla 2.5 and Joomla 3
Firefox 4+

IE (Internet Explorer) 8+

Google Chrome 10+

Opera 10+

Safari 5+

Development Environment

The requirements are the same for both Joomla 2.5 and Joomla 3

During development process, localhost is preferred. You can use the following servers
on your PC to develop your site.

Windows

WAMPSEVER
XAMPP for Windows

Linux
LAMP Bubdle
XAMPP for Linux

Mac OS



MAMP & MAMP Pro
XAMPP for Mac OS

PHP Settings

Most of the time installation problems are due to limited resources, for example on
shared hosting servers. Here's an overview of the PHP configuration settings you should
check and increase, if needed.

Setting Description

post_max_size Amount of data in a single form submission using the POST
method.

upload_max_filesize  Size of an individual file uploaded.

max_execution_time Time in seconds a script is allowed to run before it is
terminated by the parser.

memory_limit Amount of memory in bytes that a script is allowed to
allocate.

You may need to allocate more resources for PHP by modifying the php.ini file directly.
If this is not possible, you can try setting the PHP settings through an .htaccess file on
your web server. Though this also depends on your hosting server, if it allows the usage
of .htaccess overrides.

To change the PHP configuration through the php.ini file, use the following syntax.

# example of recommended settings
post_max_size = 8M
upload_max_filesize = 8M
max_execution_time = 60
memory_limit = 128M

To change the PHP configuration through an .htaccess file, use the following syntax.

# example of recommended settings
php_value post_max_size 8M
php_value upload_max_filesize 8M
php_value max_execution_time 60
php_value memory_limit 128M


http://www.php.net/manual/en/ini.core.php

File Permissions

After installing the template your website stays blank, just because your Style sheets
and JavaScripts aren't loaded? This might because the web server is unable to access
these files. Make sure that you have set the right file permission to the following
directories used by the template

Permissions are inherited from the parent folder. If you set the specific template folder
(e.g. /templates/ospt3map) and all sub files/folders to the correct permission but the
whole Joomla media folder have lower permissions it will not work. Best way is to alter
the permissions of the top level folder. Sometimes Joomla root directory has too low
permissions and you wonder why it is not working....

Note:

Always avoid 777 permissions. If your web server has problems with the CHMOD 755,
you can also try 775 and lastly 777 in this order.

Changing files permission
So how do you change the permissions for files and directories? Here are two step-by-
step guides.

1. Using your FTP client

Open your FTP client or if you don't have any download FileZilla and install it.

Use your FTP client to login to your server and browse to your web root directory.

Right click on a directory which you want to change the permissions on and click File

Permissions....

The Change File Attributes dialog, let's you check the options as shown below or type

a numeric value like 755. Make sure the Recurse into subdirectories option is checked.
Then hit the OK button.

Remote site: |/joomlal?_installer E] 8 O O  Change file attributes

Please select the new attributes for the

v Jjoomlal7_installer directory "templates".
2 administrator
? cache Owner permissions
? components
2 images @Read @Wrire @Execute
Filename # Filesize  Filetype Last modified Permissions | Owner/Group —
Croup permissions
language Directory 15/09/2011...
libraries Directory 15/09/2011... ™ Read [ ] Write ™ Execute
lnne Nirarrnns 15/narnnil
plugins Directory 15/09/2011... B
Directol 15/09/2011...
4 Download : Y 109/
tmp % Add files to queue Directory ~ 15/09/2011... ™ Read [ ] Write ™ Execute
LICENSE. Enter di N 4 ASCIl Text 12/12/2009...
nter directo
README, Ty ASCH Text  08/01/2011.. Numeric value: 1755
configur| i php-file 11/08/2011... You can use an x at any position to keep the
htaccess  Create directory ASCIl Text  07/04/2011... permission the original files have.
index.ph  Refresh php-file 21/02/2011... BRecurse into subdirectories
bots.t ASCI Text 02/04/2011... — . . .
fobots-S Delete ex 104/ (») Apply to all files and directories
web.conl ASCH Text  07/04/2011... - .
Rename () Apply to files only
Copy URL(s) to clipboard () Apply to directories only
SEEE File permissions... | RS Cancei

Tip: After applying new permissions some FTP clients require the file view to be
refreshed. Otherwise the old permissions will continue to show...
Note:



Using a FTP client may also change file ownership to the FTP user of the files/directories
you changed the permissions on. This can cause problems on some web servers. To
avoid this you can use a Joomla component like eXtplorer to update the permission
through the Joomla administration.

2. Using the eXiplorer Joomla component

Download eXtplorer file manager Joomla component and install it. It allows you to
edit, delete, copy, rename, archive and unpack files/directories directly on your
webserver.

Login to your Joomla administration, go to the eXtplorer component and browse to
the directory which you want to change the permissions on.

Right click on the directory and choose Change Rights

Check the options as shown below. Make sure the Recurse into subdirectories option is
checked. Then hit the Save button.

. @ plorer Quick Jump To: | Startseite v

==
Directory
A ome BReoas A, searen | [JB 1 (1 [X] ) 7) B & & % @ [Swowbrectoes| | | Chanoepermissions ]
Name @ Type Modified Perms templates
G5 admin [m] Diff Directory  2010/04/23 13:43 755 (rwxr-xr-x) S — —
cache Tl | Rename Directory 20111103 17:57 TS5 (rwxr-xr-x)
@ cacnq L Vi v 0
comp L Copy Directery 2011/0118 12:22 TS5 (rwxr-xr-x)
G comp L) v w o [
image Move Directory 2010/04/23 13:43 TS5 (rwxr-xr-x)
G imagg [0 [V x v x [V x
bincluc [P_, Change (chmeod) Rights (Folder/File(s)) Directory 2010/04/23 13:43 TS5 (rwxr-xr-x)
blangu ’E Delete Directory 2010/04/23 13:43 TS5 (rwxr-xr-x) .
; . ) o . Recurse into v
bllbrar EI View Directory 2010/04/23 13:44 TS5 (rwxr-xr-x) subdirectories?:
blogs & Directory  2010/07/21 09:52 755 (rwxr-xr-x)
bmedi _' Directory 2010/04/23 13:44 755 (rwxr-xr-x)
[ed Archi
55 modu | e Directory 2010/07/21 11:29 755 (rwxr-xr-x) SiakE, Cagesl
( |
bplugir B Directory 2010/04/23 13:44 TS5 (rwxr-xr-x)
Cirss | 3€ Cancel Directory 2010/04/23 13:44 755 (rwxr-xr-x)
btemplates 4 KB Directory 2010/06/22 17:27 755 (rwxr-xr-x)

Page 10f1 [ Done.



Extensions supported

OS Property component & modules
T3 Framework

JM Slideshow

OS Content slideshow

OS Facebook like

BT login module

OS Property Featured Agents

NoohrowON~

Supported Joomla pages

Login

Offline Page

404 Page
Contact Us
Registration Page
Edit User Profile

AL ol ol A e



Template packages

When you extract file: Joomla!OSPRealestate_template, you will see 3 folders:

Quickstart This folder contains the template OSPRealestate for Joomla 3.x
Joomla!OSPRealestate_template_quickstart.zip

Package This folder contains the installation version of template, modules
and plugins

OSPRealestate_template_installation.zip : Template installation
file

plg_system_13.v2.3.0: T3 system plugin

mod_mod_bt_login.zip: BT Login module

www.joomdonation.com



User guide

I. Plan your site Development

Overview:

Making a New Site 2 - If you are planning to make a new site, then use our Quickstart
package to clone the demo site and replace the demo content with yours. Check
How to install Quickstart Package.

Installing on your live site 2 - If you are planning to use this template on your already
live site. Then you should follow How to make your site look like demo site guide first to
know about the steps involved. Then you can follow up the user guide below.

1. Install OSPRealestate template with Quickstart Package

a. Infroduction and preparation

In All Joomla templates packages created by Ossolution you can find Quickstart
Package. Quickstart Package allow you install in few clicks Joomla template, Joomla
extensions and Demo data (with OS Property installed), in final you get full Joomla
website.

Please extract file JoomlalOSPRealestate _template_quickstart.zip for Joomla 3.x.

b. Uploading on server

Through FileZilla or another FTP software, upload all files from “JoomlalOSPRealestate
y_template_quickstart” folder to your welbsite directory.

c. Beginning of installation

Open your web browser and navigate to the folder that you uploaded your Joomla
package. You will see initial Joomla installation page:



Joomla! 2.5.3 Installation

Choose language

1L R ULINE T
Select Language

Flease select e language o use dang the i TV O S

Toom|st instalenon sheps! Afrikaans (South Africa) ,g]

3:License Arsbic Unitag(fmyd ieal)
Arebeycanca (Azarbaycan)

4:Database Benopyoan (Banopys)
Bulgarian (B nrapost)

5:F P Configuation Bengali (Bengladesh)

Bosansk: (Bosnig)

Catalon
Kurdish Sorani (w4

2:Prednstaliation check

6: Contiguration
7:Finish

Euskera(Besque)
Persian (guld
Fonh (Suomj
Frangais (F1)
Scottish Gasle (GB)
Galcian (Golza)

i}

Joomle(® |5 free software rdassad under the GV General Public Licerse,

Select your language and press "Next".

www.joomdonation.com



d. Pre-Installation Check

This page will give you a sense of your server compatibility. The top section of items
should all be green and 'Yes'. If any are not (they'll be red and say "No") then you will
need to take action to correct them.

Joomla! 2.5.3 Installation 1 Joomial

Pre-Installation Check checkagain ) () previous tewt {1

1: Language
Pre-installation check for Joomla! 2.5.3 Stable [ Ember ] 15-March-2012 14:00 GMT:

¥ arvy of these Paens is not swported (macked a3
No) then plesse the sctions to correct them, PP Version >=S5.2.4 Yes
3ilicense Falure 1 do 50 coukd lead to your Joom sl
installston not funcioning correctly. 3 Congresskn Suppart b
XM, Supgart Yes

(mysdf, mysddiy
5:FTP Configuration N Py sar Suppcet
BON Suggert
61 Configuration configuration ohp Writasble

2 Pve histallation check

4:Databaeo

7:Fmish
Recommended settings:

These seings are recommendad for PHP in order
1 erdure Sl companbity with Jocenls,

Mowerer, Joomilal wil stll cperate £ your sefings
b rot qute match the recomm ended.

i

v

QEQQQQQQQg’
3893889§S§

Jooesl 90 s frem softmare rdeased under the GV Gerersl Fuble Leree.

If all items green and "Yes", press "Next".

www.joomdonation.com



e. License agreement
This is the software license agreement for Joomla! use, and simply requires you to press
'Next' in the top right corner after reviewing.

Steps License

1:Language
GNU General Public License
2: Pre-installation check
Table of Contents

o GNU GENERAL PLBLIC LCENSE
o Presmntie
A:Daabase o TERMS AND CONDITIONS FOR COP YING, DISTRIBUTION AND MOOF ICATION
© Howto Apdly These Tams 1o Your NewProgran s

¥ilense

5:F TP Conflg
GNU GENERAL PUBLIC LICENSE
BECWfoEten Version 2, dune 1991

7:Finish Copyraght (C) 1909, 1991 Free Software Youndatics,
£ Texple Place ~ Suite 30, Boszton, MA onll'lm, ok

Treryora is persitted to copy and distribute verbacim copies
of thir license dooument, bux changing 1t is ot allowed.

Preamble

e hoansas Br most sotvese we desgrnd 10 take away your teadon 10 shire and crange 1. By contrast, the GNU Geneesl PLtiic Licenss is indended 80
mmuommmmmmmmmmumuumm Ths Geneeal Putiic Licanse spplbes 50 Mot of
Foundatian's sotware av310 My dher progras whose sinrs COMmE 10 uing & (Some otfwe Froe Sofware Foundation sotvers it
coered by the GNU Librry Gereral Putiic License Inatead ) You can apgly it 10 your programs, 100

Vin e spenk Of 100 SOTWAD, wh & oRTOg 10 Famdom, Nt pice. Our Gormedl Putic Lioansas s designed 10 make siee 1hat you hae the teedon
10 distande COpies Of St S0 veew (M Charpe ¢ LTE Serice if yOu wish), Ihat y0u HCHIVE SOUCE COBE OF Can Ot 1 i1 y0u wand it 1hat y0u Con Charge
the sotware or use peces of it Toe and that vou oon o o

To prtoct your ights, we fred 1o make restrictions thit Krisd anyonn 10 dorry you s Aghs of 10 a2k you 10 surmender the rights, Those restactives
transiale 10 Cortain resporaibiies e you If you datrdate copees Of the SUlvare, O If you modty &

For oxanpie, (1 you SHtAle CODES OF SUCh 8 Program , Whthar Gradis 0 B & I8, Y00 MAnt GV T mciiert s o S righes (hal you b, You must o e
re that they, 100, SeCED O Can Ot the $0Urte COSe. ANd yOu MLt Showtham thess tem 3 50 thiry krowihnit rights

e protect your rights weh two steps: (1) copyright the sotware, and (2) ofter you ths license which glves you legsl parmission 10 copy, dateute sndior
modl e sotware

Joom|® is free software rdeased undar the QU Geceral Publc Leerss,

www.joomdonation.com



f. Database Configuration
In page Database configuration you will need to enter the Hosthame, User name,
password, and database name for the MySQL database you have set up.

Joomla! 2.5.3 Installation 1 Joomial’

FTP Configuration

FTP Configuration (Optiona! - Most Users Can Skip This Step - Press Next to Skip)

On some servars You may heed 1 feoude FTP Basic Settings
wthag Enatie FTP Layer * 0w
w*m""wm'm' Wamng’ 2 & recom mandad to awe B
ool FIP ernane Bk andf ecter yaur FI¥ cmemame exch
For security reasars, & 13 bast to Creste 3 sepr st tme jou awer K3,

SF TP Confgaration FTP user account with accms 1 the Joomly! Wanng! B & recommeniod 10 ave Iy
rstallabion cefy and nek the entre web server. FTP Password Dok and entee pour FTP password aach
&2 Confipuraion Your host can assst you v the ome pou Oawfer fles,

Note: ¥ you are instaling on & Wiedons FTP hoot Pah

TiFmnh Cpevasrg Systam , the FTP Liver & rek tegured ( :

« Mvanced Settings
FTP Hst. 127001
FTP Pat r4)

Sowe FIP Passwcrd * @ Ovs

Jooml 8 is free software rdessed under the GNU Gener o Publle Liceres,

www.joomdonation.com



g. Main Configuration

On Main Configuration page you can add a site Name, username and password for

first installation set admin / admin, and email for the administrator. IMPORTANT for
successful installation Joomla Template Package press "Install Sample Data".
Note: Please select option Default English OSP Real estate (GB) Sample dataq, if you

don't select this option, the system will only install the blank Joomla site into your site

and you won't have the site like the demo of template.

Joomla! 2.5.3 Installation

¥ Joomial

Steps

1z Language

2: Prednstallstion che dk
J:lkcense

A:Daabase

5:F TP Configwation

b2 Condigue ation

7:Fmish

o

Main Configuration

Ske Nome
Erter the name of your onls! ste.
Cotoral:

You can 850 enter Meta Description and Meta
hewords for your site.

You may slso decide # e st frontend may be
immadiately yesilable or nt ster P ieutalgion is
comgioted.

Corfirm the Admin emall and Password,

Enter your emal address. This will be the emal
address of the Web site Super Adm inistrator,
Enter 5 new password and then confirm & in the
wpeogris Aekds. You may hangs the S st
usetnane adein. These will be the Username and
passward that you witl (e o loginto the:
Adminesy ator Control Fanel 82 the end of the
ratalaton

¥ you e migrating, you can ignar e ths section,
Your current settings will be sutomaticaly

iy ed.

Load somple data

Ivpartant!: Itis sty ongly recommendad thet new
Jcmlal wsers inatall the default sasple data, To
0 ths dhok. on e betton devire mowng to e
re:xt stage.

1, Savple data: Before lossrg T wntal oo,
Y0 G gopuiate the site database with data.
There are two ways o do this:

1a. Defoult sangle dats can bo irsartnd. To do
tes, make sure the Defaut Enghieh (GEB) Sampie
Data 15 displiyed i the dropdown and cick the
Instal Samgle Data buton,

b, Custom savple dota con be inssrted To do
ths, chixes & avadeble sam le data i the
@ cpdown and dick the hstall Saimgle Oats tutton

2 Clean Installation: ¥ you wish to perform &
dean katdlation, erter S 5 name, admin

() Previous e ()

Basic Sattings
Ske Name * OrdaSoft
+ Advonced Settings - Optional

Your Emasl * Suppon@crdescft com
Aden Username * edmmn

Adren Passwoed *

Corfem Adnin Passwoed *

Samole Data sat Defout Engish (GE) Sampke Dota v

hstaling sample dsts & strongy recommended fiv bagimers. Ths
el instal sample content At & included i the _bomla? sistsllstion
Dackage

o &l and choois 8 pasewcrd. Then eoceed b

www.joomdonation.com



h. Finish
Congratulation, Joomlal is now installed! The last step needed is to remove the
installation directory!

Finish

Congratulations! Joomia! Is now Installed,

2: Prodnstallation check
Gd&wsehxmmuzm Joom la? Web st
. o Adrin button to t you to
Rxticsese ity gtoe logh. ol
4:Daabase On the Joom lal Communety Ste, you wil find a list
of links to avalsble language packs as wel & links
to langusge relatnd the yomls.
5:FIP Configueation famiy of stes, (e PLEASE REMEMBER TO COMPLETELY
6: Configuration Cick.the buzon on the right 1o ogen the REMOVE THE INSTALLATION FOLDER.
& Commundy Ske n 2 new window You will not be able to proceed beyond this point until the installation
directory has been removed, This is a security feature of Joomlal.

FRemowve instalation fokder
Administration Login Details

7t Findsy

Usernam & - adomn

Joonded i your own language?
Wisk the Joomis! Community Ste for languege packs downloads.

Joon| 89 is free software rdeased under the QiU Gererdl Pubic License,

Note: In the first time launching site, the site will load a bit slowly, no worry, because the
system must update cities into OS Property database.

www.joomdonation.com



2. Manual installing on your live site

2.1. Installing Template on your Joomla!

Install the Template: Now install the Template on your Joomla 2.5 and Joomla 3.x
system. Follow This Guide (http://youtu.be/IXEAUP2wicUl) if you are not familiar with the
installation procedure.

The installation template files is “*JoomlalOSPRealestate _template_installation.zip™ in
folder Installation > Template

Template installation tutorial: http://youtu.be/giRHMbkg-Iw

Extension installation tutorial: hitp://youtu.be/zAND85B32H0

2.2. Installing T3 Framework 2 Plugin (T3 system plugin)

You must install T3 plugin if you want to use OSP Real Estate template. The plugin file is
“plg_system_t3.v2.2.1.zip" in folder Installation > Plugin

Download the T3 Framework 2 Plugin (T3 System plugin), Install and enable if.

If you are new, then follow This Guide (http://youtu.be/t8n7h94Vzss) to learn to install
plugins in Joomla.

3. Template Configuration

Overview:

OSP Realestate template will install with Settings used in the demo site. So you can
delay the configuration until you complete the setup (installing the other modules /
plugins used in the demo site).

Once you have completed the setup, you can come back to the template backend
and check the various options for customizing your template.

Note: T3 V2 template configure are same in Joomla 3.x and Joomla 2.5.

Links to resources on T3 V2 Framework templates and advance configure options :

o Overview (http://t3-framework.org/documentation/intfroduction#overview)

o Installation Guides (http://13-
framework.org/documentation/installation#quickstart and http://13-
framework.org/documentation/installation#quickstart)

e Mega Menu - A missing menu system for Joomla! (http://13-
framework.org/documentation/menu-system.html#megamenu-config)

Note: When you see “Missing T3” error on the frontend.
13 framework 2 based templates need the T3 Framework Plugin to be installed and
enabled.

Now, we will go through the OSPT3Map template configuration:
Extension > Template managers > OSP Realestate


http://docs.joomla.org/Installing_a_template
http://youtu.be/iXEAuP2wicU
http://youtu.be/giRHmbkg-lw
http://youtu.be/zAhD85B32Ho
http://www.youtube.com/watch?v=t8n7h94Vzss
http://youtu.be/t8n7h94Vzss
http://wiki.joomlart.com/wiki/JA_T3_Framework_2/Overview
http://t3-framework.org/documentation/introduction#overview
Installation%20Guides
http://t3-framework.org/documentation/installation#quickstart
http://t3-framework.org/documentation/installation#quickstart
http://t3-framework.org/documentation/installation#quickstart
http://t3-framework.org/documentation/installation#quickstart
http://wiki.joomlart.com/wiki/JA_Template_Framework/Navigation
http://t3-framework.org/documentation/menu-system.html#megamenu-config
http://t3-framework.org/documentation/menu-system.html#megamenu-config

a. General

B QSP Estat = &~

@ Template Manager Joomlal

<>LESStoCSS |~ # ThemeMagic & Megamenu % Close @ Help Click here to get more help
Current Style | OSPrealestate - Default v Style Name = | OSPrealestate - Default Default = All
Overview General Theme Layout Navigation Add-ons Custom Code Assignment
—
The following settings will be applied for all styles, themes and layouts 9

i
3
ul

Development Mode | Global

ThemeMagic | Glotal

Q

Legacy Compatible | Global

- .
(o]
uu

HRE

Responsive | Global

Build RTL CSS | Glebal

[=]
ul
ul

T3 Assets Folder |Global t3-assets

e}

Show T3 Logo | Glosal N

Optimization
Enable compress CSS/JS. These options only available when Development Mode is off

Optimize C§5§ | Global

I
3
ul

Optimize J§ [Global

i
5
3

Core Joomla!
Enhance Core Joomla! options

Link Title for Article View | Gicbal Use Global v

Sefting Valuve Description

—H

Development Mode  Off When Development Mode is enabled, less is used

instead of css

ThemeMagic On Enable this option to access ThemeMagic
customization panel

Legacy Compatible  Off Load some important compatible styles for
Bootstrap 2 and Font Awesome 3.x

Responsive On Enable this if this femplate supports responsive
layout. Switching this option need re-build LESS to
CSS.



Optimize CSS Off When you enable this option, compressed CSS files
will be used (.min.css files)

Optimize JS Off Combined and compress Javascript files

Enable Theme Magic
ThemeMagic is a real time theme customization tool supported by T3 Framework. It
allows you to customize any theme without fouching in the code.

Step 1: Enable ThemeMagic
In the General tab, enable ThemeMagic then access ThemeMagic's working panel by

clicking on ThemeMagic.
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Step 2: Select the theme to customize

For Lease Properties

For Sale Properties

Agents
AGeENiS »

Agent register

Companies »

Company register

| ¥ y o0
MViap se

TEMPLATE SETTINGS

Select color sample for all params

Select Layout

default B
oo [

Tips: Once ThemeMagic is enabled, you can access ThemeMagic from your front-
page by adding "¢tm=1"after your site url (example: http://your website.com/etm=1)

You can read more about ThemeMagic at this page: http://13-
framework.org/documentation/bs3-customization#theme-magic or watching the
tutorial at: http://13-framework.org/documentation/bs3-customization#theme-magic

www.joomdonation.com


http://your_website.com/?tm=1
http://t3-framework.org/documentation/bs3-customization#theme-magic
http://t3-framework.org/documentation/bs3-customization#theme-magic
http://t3-framework.org/documentation/bs3-customization#theme-magic

b. Theme

Il Tamnlata Mananar =dit Shila
&
«f> Compile LESS to C55 # ThemeMagic & Megamenu X Close @ Help | < Click here to get more help
Therme Lyt Mavigation Agslgnment
The visual settings below are for themes of your selected style. You can abways use the ThemeMagic tool located on the top-right panel for further advanced settings 9
Theme - Use Default - -
Logo Type Image -
Site Name *Your site name goes here
Slogan Yfour slogan goes here
Logo Image @ imagesflogo.pn  Select | X
~*iew Site owsnurs oAdmms &0 Logout Joomlal 31.5 — @05 Property T2 template 2013
* . °
Setting Value Description
Theme Default OSP Real estate supports 5 colors themes by

default: Default, Red, Green, Pink, Blue and Teal.
Default theme is: Default

Logo Type Image Text or Image

Logo Image Browse image to replace current logo image

- Use Default - *
green

pink

red

turguoise

Available themes in OSP Real Estate template
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c. Layout

B
@ Template Manager Fdit Joomlal
<>LESStoCSS |+ # ThemeMagic s Megamenu X Close @ Help Click here to get more help
Current Style | OSPrealestate - Default v Style Name = | OSPrealestate - Default Default = All o
Overview General Theme Layout Navigation Add-ons Custom Code Assignment
—
Based on Bootstrap Grid, you can add up to 6 module positions to a spotlight area which can be resized by adjusting the resizer bar to the lef/right. 9
You can change the module position by clicking on the configuration icon on the top right.
Position & Responsive default M I Delete % Purge Fa
Configuration
Module Positions Responsive Layout 'O Reset All

Reset Positions

Auto Auto Auto Auto Oﬂ-canvas
head-social head-contac  head-login head-search Sidebar
12
off-canvas
12
mainmenu
(OSP REAL ESTATE
12
slideshow
12

advance-search

Auto Auto Auto
position-1 position-2 position-3

1 2 4 5 i}
12 12 12
sidebar-1 message sidebar-2
12
component
12
slideproperty
12
banner
Auto Auto Auto
position-5 position-6 position-7
1 2 4 5 i}
|
Auto Auto Auto Auto
footer-1 footer-2 footer-3 footer-4
1 2 3 IZ‘ 5 6
Auto

footer



There are 3 layouts that are used in the template. Select the style that you want to
work on, then assign the layout for that style accordingly.

otstrap Grid, you can add up to 6 module positions to a spotlight area which can be resized by adjusting the resizer bar td
ge the module position by clicking on the configuration icon on the top right.

Position & Responsive default Save as Copy Tl Delete % Purge
Configuration

default-content-left

default-content-right sive Layout

default

Here, you can change the layout structure, module positions in the layout, and more.

to 6 module positions to a spotlight area which can be resized by adjusting the resizer bar to the left/right. €
king on the configuration icon on the top right. Select a position

Banner [banner] -
default v Save as Copy W Delete % Purge e ] e

Sidebar 1 [sidebar-1]

Module Positi R ve Lavout Sidebar 2 [sidebar-2] A 'R .
odule Fositions esponsive you Slideshow [slideshow] . ese

Slideproperty [slideproperty]

Advance Search [advance-searc Paosition
Mast Col [mast-col] I

Footer [footer]

Pasition 0 [position-0]

Off-Canvas P it A e it A1 3
Auto Auto Auto rch

head-social head-contac head-login

12
off-canvas

A 12 [ Click here to edit position

In the spotlight block, you can see the number of positions available.
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OSP Real Estate supports multiple responsive layouts. In the Responsive layout, select
the layout you would like to configure.

L

default hd B Save as Copy

Module Positions Responsive Layout

Large Medium Small Extra Small

In each responsive layout, you can disable any module position as you wish.
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For module positions in the spotlight block, you can drag to resize.

d. Navigation

Joomilal’  Template Manager

| <> Compile LESS to C55 H # Themehagic || an Megamenu | | *® Close || @ Help ‘ < Click here to get maore help
Current Style  Ospt3map - Default - Style Name = | ospt3map - Default Default Al -
General Theme Layout L Mavigation Assignment
The tab includes settings of the Megamenu - a missing feature in Joomlal. With an intuitive configuration visuzalization, you can setup an advanced menu in a few clicks e
]
Dropdown Trigger Mouse Hover -

e

Off-Canvas Navigation |m
L]

Always show submenu |N__ﬂm

Navigation Type Megamenu -
@
Animation Elastic -
@
Duration 400
Menu Main Menu -

Field name Suggest Field Description
value

Dropdown Trigger Mouse Hover
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Off-Canvas Navigation Yes

Always show submenu Yes
Navigation Type Yes
Animation Elastic
Duration 400
Menu Main Menu

T3 supports Megamenu that allows you to display your menu flexible. Arrange menu
itfems in columns, adding any content to menu...

Home . Listing . Category Agents . Companies . Map search Advanced search Contact

For Lease Properties

For Sale Properties

Please note that, the navigation setftings are not global settings that mean in each
style, it can have difference navigation. In each style, you can display different menus
as main menu.

| e - | | | emeMagic | | = Megamen Close | | @Help = - Clickherg

Current Style | T3 Bs3 Blank - Home A t3 bs3 blank - Home & m

Menu Main Menu v Select menu for current style
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To enable Megamenu, please open Navigation tab. Enable Megamenu> option then
open Megamenu configuration panel.

U ]

<> LESS to CSS # ThemeMagic i Megamenu Then open Megamenu panel

Megamenu Configuration L] Style Name * re@=tilank - Home B Defautt
Enable Megamenu firstthen go to Megamenu settil

Enable MegaMenu m:l

Ill-l Main Menu v
Enable Megamenu first

_ayout Mavigation Add-ons Custom Code Assignme

@ Template Manager Ed

<> ESSta CS5 | ¥ # Themehdagic & Megamenu % Close © Help Click here to get more help
Current Style | OSPhaliday - Default M Style Mame * | OSPholiday - Default Default Al
Overview General Theme Layout Navigation Add-ons Custom Code Assignment

Built-in Add-ons for T3 Framework

Off-canvas Sidebar
Enable of-canvas sidebar then select effect for the Of-canvas sidebar.

Off-Canvas Effect |&lobal Slide along M

4. How to change logo in OSP Real Estate template

There are two ways to change the default logo in JA Medicare template.
#1 Upload your own logo
In order to change the logo in JA Medicare template, please follow the steps below:
Log into your site back-end
Navigate to Extensions >> Template Manager
In Styles, choose OSP Realestate - Default
In the menu section, click on “Theme” tab
Make sure to choose Logo Type = Image
Click on Select to browse and upload your ‘Logo Image’



Click Save to complete the process.
Back to your home page, and refresh to see the change.

L J

Current Style = Ja Medicare - Default v Style Name *  Ja_medicare - Default Default Al

Overview General Theme Layout Navigation Add-ons Custom Code Assignment

The visual settings below are for themes of your selected styie. You can always use the ThemeMagic tool located on the top-right panel for further adva

Theme - Use Default -

Slogan Joomla Template for Medical

Logo Image @ Images/joomiz Select X

Note:
In case you use multiple themes in the JA Medicare template.

In the Theme tab, navigate to the Theme field, then select the theme in which you
want to change the logo.

Repeat all the steps above to change the logo image.

Don’t forget to Save the changes.

Current Style = Ja Medicare - Default T Style Name * Ja_medicare - Defauit Default Al

Overview General Theme Layout Navigation Add-ons Custom Code Assignment

The visual settings below are for themes of your selected styie. You can always use the ThemeMagic tool located on the top-right panel for further adval

Theme - Use Default -
Logo Type Image =
Site Name Medicare

Slogan Joomia Template for Medical

Logo Image @ |mages/joomiz Select X



#2 Use custom CSS
Set your logo's dimensions to the standard size (xxx) and name it as
[your_site_name].png
Upload the logo file to the folder [root]/templates/ osprealestate /images/
Create a CSS file named custom.css in the following folder
/your site/templates/osprealestate/css/

If the logo size is not fit with your site’s look and feel, you can change its size with
additional styling code:
Adding a new class as .logo-image {}

For example:
.logo-image {

width: logo-width;
height: logo-height;
background:

url ("your-site/ja medicare/templates/ja medicare/images/your-site-logo.png")
no-repeat / 100% auto;,

}

.logo-image img { display: none;}
Save, and then refresh your site to see the change.

If your new logo does not appear, please follow these steps:
Log into your site back-end
Navigate to Extensions >> Template Manager
Select your template style, then click on the tab “Theme” in the menu.
In “Logo Image”, click on “X" to clear the field.
Click Save then repeat all the above steps for your other template styles.
Go to front-end to see your new logo

How to customize your uploaded logo

Small Logo

To properly display on mobile/tablet or other collapsed screens, the default logo will
be replaced by a small logo.



Overview General Theme Layout Navigation Add-ons Custom Code Assignment

The visual settings below are for themes of your selected style. You can always use the ThemeMagic tool located on the top-right panel for further advanced settings.

Theme

Logo Type

Site Name

Slogan

Logo Image
Enable Small Logo

Small Logo Image

Enable: On

| - Use Default -

Image

Medicare

 Joomia Template for Medical

® images/joomic Select X |

23 Select %

The small logo uploaded by user will be used. In case no logo is selected in the Small
Logo Image field, the default logo will be used. And how it's look

" OSP REAL ESTATE

Enable: Off
The default logo will be used.
Logo type = text

If you don’t want to use a graphic logo, you can always choose the option Text in

Logo Type field.
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OSPrealestate - Default v Style Name * OSPrealestate - Default

General Theme Layout Navigation Add-ons

ngs below are for themes of your selected style. You can always use the ThemeMa

Theme green

Logo Type

Site Name OSP Real Estate

Slogan OS Property Joomla Template

You will have a beautiful Text Logo in OSP Real estate template.

OSP Real Estate

0S Property Joomla Template

5. Installing complimentary / included extensions and Demo configuration

Custom HTML Modules : To match the design of the template, we also style (CSS) for
Custom HTML modules using different div classes. You will need to check the HTML
codes and make sure to use the recommended HTML markup to get correct display.
We provide the HTML code in this user guide.



Il. Know your Module Positions
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Latest Properties
(4]
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lil. Installation: Modules Configuration

Overview:

When you install modules of in the package, all the module parameters will have pre-
defined values. So in this part, we only list all important parameters of modules, you will
need setup those parameters to make it like the demo of template

1. Menu Configuration

There are 3 levels of configuration that you should know: Submenu setting, Column
setting and Menu item setting.
a. Sub-megamenu setting

Options to configure
sub-menu

Submenu Configuration

Add row Hide when collapse Submenu Width (px) Alignment Extra Class

] [ Jore] [wm =]
Home ~ Typography ~ Support~ Joomla! pages ~

Sample Layouts

Select sub-menu to configure 3 Columns

Full Width

Content - Right Sidebar

This setting allows you to configure the width of the sub-megamenu, add column, and
add class that style for it.
b. Column Setting

LR )

ption |
Column Configuration ° B

/remove Column Hide when collapse Width (1-12 odule Extra Class

+ - OFF B 7

Home -~ Typography - Support~ Joomla! pages ~

Sample Layouis

Select column to configure 3 Columns

Full Width

Content - Right Sidebar




In this level of configuration, you can: Add column, remove column, set width of
column, assign module to column.

c. Menu ltem

L

Item Configuration

Submenu Group Positions Extra Clazs Q, Icon ltem caption

Home -~ Typography - Support~ Joomla! pages -~
Select menu item to configure Sample Layouts

3 Columns

Login Form

Full Width

In this level of configuration, you can: enable or disable submenu if a menu item,
display sub-menus in group or not, move menu item to right or left, assign a module to
a module menu item, add icon for menu item.

Megamenu options

1.1. Enable Submenu

This is option is to show or hide submenu of a parent menu. If a menu does not have
submenu, when you enable this option, it allows you to add new submenu and add
content to the submenu.

To add submenu, click on menu that you want to add submenu (you can only add
submenu for a menu that has no child menus).

Item Configuration

Submenu Positions Extra Clags ltem caption

J_C-FF | € >
2

Enable sub-menu

About OS Calendar ~ ‘ New Destinations ~ ‘ Top Destinations ~

Select menu item to add Huotel

sub-menu

Apartrment

Camp site




1.2 Add new column/row

You can add new column or row for a selected column/row.

(2)

Click “+" button to add column

-~ Hotel
Select a column that you want I E
to add new column beside it. i

2 Camp site

. Holiday

1.3. Group submenu or not

You can group submenus of any menu item by selecting the menu item then enable

option "Group".

Group e
ON - Enable “Group™ option

Select menu item that you Documentation

want to group its sub-menus
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1.4. Resize submenu and column width

T3 allows you to change size of submenu. Select the submenu then change its size in pixel.

Column Configuration

Add/remove Column Hide when collapse Width (1-12) Module Extra Class
=] [Jow] s -
2. Set the width
Sample Page 1 Sample Page 2
Contacts MNews Feed
Smart Search Registration Form
Advancesd Search Offline Page

After changing size of the submenu, you can change size of a column, select the
column and set the Width (total is 12).

Column Configuration

Addiremove Column Hide when collapse  Width (1-12)  Module Extra Class
+ | - OFF B v
2. Set the width
e e —— m
Sample Page 1 Sample Page 2
Contacts Mews Feed
Smart Search Reqgistration Form

Advancesd Search Offline Page




1.5. Style Megamenu
You can style for any level of Megamenu: menu item, column, submenu by adding a

class to Extra Class field

Submenu Configuration 2 add extra classs to
Addrow  Hide when collapse  Submenu Width (px) Alignment Extra Class style for selected element

+ - 450 = = = = menu
1. menu, submenu, column
Home ~ Typography to add style la! pages ~ Layout ~
Sample Page 1 Sample Page 2
Contacts News Feed
Smart Search Registration Form

1.6. Add icon for menu item
There are 2 ways to add icons to the menus.

a. Using megamenu
You can add class to define icon that you want to add to menu item, or you can use

classes of Bootstrap and Font awesome

1. Bootstrap 3 icon list
2. Font Awesome 4 icon list

Item Configuration

Submenu Group Positions Extra Clazs Q, Icon

2. Add icon class

L = icon-home

iZ Typography ~ < Support~ e Joomla! pages ~ 23 Layout ~



http://twitter.github.com/bootstrap/base-css.html#icons
http://fortawesome.github.io/Font-Awesome/icons/

b. Using Joomla menus

= Menu Manager: Edit Menu Item

¥ Save &Close || + Save&Mew || [hSaveasCopy || @ Close |

herw Title ™ Mew Destinations Alias | nevw-destinations

Details Other setting Link Type Page Display Metadata hodule Assignment

Lirk Title Attribute

Link CS5 Style globe

Link Image @ Select | %

And here is the result at front-end

Home . Listing . Category Agents . Companies . Map search Advanced search Contact

-

For Lease Properties

For Sale Properties

2. JM Slideshow (Non-commercial slideshow extension)

Author: Joomlaman

Url: hitp://www.joomlaman.com/joomla-extensions/22-im-slideshow.hitml

Overview:

With JMS module, you can create slideshow on a site which include various images
and article fragments or texts defined by a user. Thanks to slide management system
integrated in the module, its support is very easy, intuitive and fast. With the new
method of creating module styles you can easily move your slideshow style from one
template to other template.

Documentation:
hitps://www.youtube.com/watch?v=hZqgFitZbBBI
Compatible:

Almost browsers like |E 9, 10, Firefox, Opera, and Chrome. We noted some errors of this
slideshow module in IE browser.
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http://www.joomlaman.com/joomla-extensions/22-jm-slideshow.html
https://www.youtube.com/watch?v=hZqFitZbBBI

Field name

Position

Basic Option

Responsive

Image Width

Image Height

Image Style

Source Options

Slider Source

Suggest Field value Description

Slideshow

Yes

700 Pixels
400 Pixels
Fit

You can select one of options: Joomla
Categories, Special Article IDs, Featured
Articles, and From Directory.

With Joomla Categories, you need to select
categories of Joomla at the dropdown list.
With Special Article IDs, you need to enter ID
of Arficles, separated by colon.
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Note: You can use other slideshow if you want, or you can use OS Property slideshow
to show properties on the slideshow.

3. OS Quick Search module
This is quick search module of OSP Real Estate template, but it is used to search
properties from OS Property extension

for sale

For lease

e | . P -
/ \ / \ / \
{ o \ . = \

Os quick seorcH moﬂdOIe at front-end

O | - Guick Search for 05-Healestate template advance-search Quick Search for Selected only Public All 110

05-Realestate
template

Os quick search module at back-end

Parameters Value

Position advance-search

Property types
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http://www.joomdonation.com/84-os-property/35005-slideshow-module.html

4. BT Login module

& login # Register Q search...

LOGIN TO YOUR ACCOUNT
Don't have an account yet? Register now!

Username *
Password *

Remember Me

* Forgot your password?

* Forgot your username?
BT login module at front-end

BT Login
Site)

BT Login Module Version 2.6.0 BT Login module is alternate Joomlal logir
standard login module in the default position. Features Ability to run...

Show full description...

Align opticn | Left v |
Display Type | Dropdown |
Mouse event | Click |
Login Redirection Page | Default v |
Logout Redirection Page | Default " |
Name/Usemname | Username * v |
Log out button

Registration Button

Login Button

BT login list module configuration

www.joomdonation.com
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Parameters Valuve
Position head-login
Align option Left
Display type Dropdown
Mouse event Click
Name/Username Username

5. Featured Properties (Random Properties)

This is module of OS Property extension, and it is used to list properties in a lot of filter
parameters

Featured Properties

10,000 Sq. Ft,

4 Bedrooms,

3 Bathrooms, 2 Garage
K¢ 500 000,00

10,000 Sq. Ft,
4 Bedrooms,
3 Bathrooms, 2 Garage

o K¢ 2299 900,00
FORRENT  #Siged

10,000 Sq. Ft,

4 Bedrooms,

3 Bathrooms, 2 Garage
KE 1 500,00

FOR RENT SRSEE “iae
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Parameters

Position

Module Class suffix

Direction

Theme

Show small description

Show property price

Show address

Show bathrooms

Show bedrooms

Show rooms

Show Category name

Show Property type name

Limit Title Words

Show photo

Value

Position-6

_properties

Vertical

White

No

Yes

No

Yes

Yes

Yes

Yes

Yes

Yes



Width size of photo(px) 165

Width size of each property element (px) 330

Height size of each property element 160

(Px)

Number of Properties 3 (or more depend in your setting)
Newest properties Yes (or No)

Show featured properties Yes (or No)

Select category You can select to show properties on

specific category

Select property type You can select to show properties on
specific property type

Header Class



Title” ' Featured Properties

Module Menu Assignment

Random Properties

Display properties with a lot of filter parameters OS Property

Module Class Suffix

Direction

Theme

Show small description

Show property price

Show address

Show bathrooms

Show bedrooms

Show reoms

Show Category name

Show Property type name

Limit Title Words

Limit Words

Width size of photo(px)

Show photo

_properties

@ Vertical
@ Horizontal

@ Black
@ White

Width size of each property element (px) 330

Height size of each property element (px) 160

Number of Properties

Newest properties

Show featured properties.

Select category

Select property type

=N
-

Module Permissions

Advanced

| Select Category

[ select property type

www.joomdonation.com

Show Title

T e

Position

\ position-6

Status

Published

Start Publishing

= |
Finish Publishing

= |
Access
[ Public v
Ordering

‘: 1. Featured Properties

Language

[

Note



6. Facebook Like Box (Non-commercial slideshow extension)

Ossolution Facebook Like Box is designed to make it as easy as possible for your members
and guests to connect with you on your Facebook Fan page

FACEBOOK LIKE BOX

Field name

Position

Load Javascript

Output

App ID

Facebook Page
URL

Width

Height

Find us on Facebook

PNl OS Property
- + Like
PROPERTY

OS Property

EET

e ® |
DSy =0 W

§ Facebook social plugin

Suggest Field value

Footer-4

Load Every Time

HTMLS

https://www.facebook.com/pages

[OS-Property/668221079857560

270

220

Description

Include the Javascript (If no you
must include it yourself)

How button is rendered

Put your App ID here

URL to your facebook page

Choose the width in pixels

Choose the height in pixels


https://www.facebook.com/pages/OS-Property/668221079857560
https://www.facebook.com/pages/OS-Property/668221079857560

Show Branding

Show the Header

Custom Header
Height

Custom Header
Background Color

Custom Logo
Height

Custom Logo
Width

Logo Alignment

Custom Logo URL

Border Style

Border Width

Border Color

Background Color

Color Theme

Show Faces

Yes

Yes

Center

None

Dark

Yes

Show the Facebook Branding
Below the Box

Choose the height in pixels

Choose the header background
Color in hex

Choose the height of logo in
pixels

Choose the width of logo in pixels

Choose how to align the logo

This is the path to the logo image

Choose your border style

Choose your border width

Choose the border Color in hex

Choose the background Color in

hex

Light or Dark

Standard Layout Only



Show Stream

Show Wall posts

Font

Language

Yes

No

Arial

English (US)

For Places, specifies whether the
stream contains posts from the
Place's wall or just check-in from
friends

Choose a Display Font

Language Selection



7. Modules in Position “Off-canvas”
These modules are shown in Off-canvas position. They can be seen by click on icon

on the top menu. They are Main menu Change template style modules. Of
course, you can assign other modules if you want.

Main Menu -

Listing o

Change template styles

For Lease Properties

For Sale Properties Header Class: gear
Category
Agents .

Agent register
Company

Map search

Advanced search

TEMPLATE SETTINGS

Select color sample for all params

Select Layout

default |E| |
Apply Reset B

www.joomdonation.com



8. Module Mod_featuredagents (Top Agents)

Overview:
List agents in OS Property

Top Agents

1234

on

(=)

6789
w

[N

123456789
23456789
Field name Suggest Field value Description
Position Position-5
Number 4 Number featured agents that will be shown
agents/owners at frontend of module
Sort by Agent/ Owners Sort features by

name



9. Module Latest Properties (Mod_os_contentslider)

This module helps you create a slideshow of your properties from OS Property with cool
effects and various configurations: covering layout, animation control, auto thumbnail
creating, images resizing, articles numbering, ordering...

Latest Properties

FOR SALE
# sqFt & Bedooms § Bathrooms - Sq Rt  Ba # SqFt & Bedooms § Bathrooms
Harbor Islands Intracoastal Waterway Beach Back With Pool Beach Front Vacation Rental
1135 Hatteras Ln, Accord, 33019, New York, US, Accord, 5 Sinnamon Bei New York, US,
33019, New York, US Accord, 321
INT OASTAL POINT LOT IN HARBOR Basement, Lau om, Spa/Hot Tub, Central Air,
S, A DOUBLE GATED MARINA COMMUNITY WITH Fireplace, Swimming Pool, Dining Room, Main Floor Fireplace, Swimming Pool, Dining Room, Main Floor
ENDLESS AME.
Field name Suggest Field value Description
Position Slideproperty
Global Setting
Module class suffix _properties
Grid Setting
Module Width Auto Width size of one property in the slide
Module Height Auto Height size of one property in the slide
Auto adjust height Yes Auto adjust height effect

Number of Rows 1



Number of Cols 3

Source Setting

Source From OS Property

OS Categories

OS Property types

States/Provinces IDs

City IDs

Show featured Yes/No
properties only

Property IDs

Number of Articles 12

Articles Sorted By

Images and links

Use infro image Yes/No

Select OS Categories in the multiple
select list

Select OS Property types in the multiple
select list

States/province IDs, separated by
colon.
For example: 1,2,3,4

City IDs, separated by colon.
For example: 1,2,3,4

Do you want to show featured
properties

Property IDs, separated by colon.
For example: 1,2,3,4

Maximum properties that will be shown
on the slide

Choose one of conditions to sort the list
of properties

Do you want to use infro image



Use caption

Use link A

ltem layout Setting

Title Opftion

Show title

Limit Title By

Title Max chars

Yes/No

Yes/No

Yes/No

Word/Character

Property information option

Show price

Show category

Show property type

Show address

Intro Text Option

Show intfro text

Limit Description By

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

Word/Character

Do you want to use caption

Do you want to use link A

Do you want to show fitle

Choose limit fitle by word or by
character

Enter number maximum chars of title

Do you want to show properties’ price

Do you want to show categories name

Do you want to show property types
name

Do you want to show address of
properties

Note: Even when you select Yes in this
field, the address won't be shown if the
property has value of field Show
Address is No

Choose limit title description by word or
by character



Description Max Chars

Show category name

Show category name
As Link

Show Read More

Show Date

Show Author

Image Option

Show Image

Grad img in full text

Check existing image

Alignment of image

Equal height

Auto generate
Thumbnail

Thumbnail width

100

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

Left/Right/Center

Yes/No

Yes/No

330

Enter number maximum chars

Do you want to show category name

Do you want to show category name
as link

Do you want to show read more

Do you want to show date of property

Do you want to show property’s author

Do you want to show image

Turn off this option for faster module

Turn off this option for faster module

Set alignment for thumbnail images.

Titles/descriptions will have the same
height

Do you want to auto generate
Thumbnail image

Enter the width of thumbnail in the
numeric



Thumbnail height

Default thumbnail

Effect Setting

Touchscreen

Image mouse over
Effect

Image Modal Box
effect

Next back effect

Navigation effect

Pause hover

Interval

Animation duration

Page Animation
Transition

Auto start

230

Yes/No

Yes/No

Yes/No

Yes/No

Slide/Fade

Slide/Fade

Yes/No

5000

500

Jswing/easelnQual/
easeOutQual

Yes/No

Enter the height of thumbnail in the
numeric

Default thumbnail

Support drag and swipe for Androids
and IOS

On mouse hover, the thumbnail image
will fade out to 50% opacity smoothly

When clicking to thumbnail, the modall
box will be shown with fullimage

Set effect slide or fade for next/back

Set effect slide or fade for navigation

Pause slider on mouse over

Set period of time to allow the module
playing.

Animation duration

Choose an animation for playing effect
in page

Auto start



10. Module Search Properties

Overview:
Display Advanced Search Form of OS Property component

Search properties

Basic information [

User Any B
type:

Category: | 4 B

Details [

Rooms: Any t‘
Floors: Any t‘

Bathrooms: | H

Bedrooms: Any t‘

Address [

State: Any E|
city any .
Address:

Ordering [-]

Sort by. Featured H
Order by: Descending H
Amenities [

[] Gas Hot Water
Central Air

M Cable Internet
Cable TV

[ Electric Hot Water
Freezer

[ Swimming Pool
[C] Skylights

[[] Microwave

[] Sprinkler System
M Wood Stove

B Fruit Trees

[7] Skylights

0 Washer/Dryer
[F] Dishwasher

[[] Landscaping

Other ]

www.joomdonation.com



Field name

Posifion

Module class

suffix

Show basic filter
form

Show details filter
form

Show address
filter form

Show Amenities
filter form

Show Other filter
form

Show category
filter

Show property
type filter

Select property
type

Suggest Field value

sidebar-2

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

Yes/No

For lease/For
rent/For sale/For
sale or
lease/Pending/sold

Description

Do you want to show the basic details search
form with fields Category, Property type and
Price

Do you want to show the address search form

Do you want to show address filter form

Do you want to show amenities search filter
form

Do you want to show the other search form
with fields like Keyword, Feature filter

Do you want to show category filter form

Do you want to show property type filter form

Select property type which you want to
display in search module



Show price filter

Show custom
fields filter

Inputbox width
size (px)

Show search form
in next page

Show search
result in current

page

Open all group

Yes/No

Yes/No

150

Yes/No

Yes/No

Yes/No

Do you want to show price filter

Do you want to show groups and custom
fields filter

Please enter the width size (pixel) of the input
box

After selecting the search criteria, you will be
redirected to advance search page. In the
top of this page, do you want to show the
search form?

Do you want to show search result in current
page.

If you select Yes, all the fields of all groups in
search module will be shown. If you select No,
only fields of group Basic Information are
shown.



11. Custom HTML modules

Custom HTML modules like Social icons, Contact information are Joomla modules, they
can't be installed as other installation modules. These module can be created by
select Custom HTML module and then, enter the content for them.

a# Module Manager: Modules

X Cancel

Select a Module Type:

Archived Articles This Module shows & list of the calendar months containing &rchived Aricles. After you..
Articles - Hewsflash The Mewsflazh Module will display & fixed number of articles from a specific catenory.
Articles - Related Articles This Module displays other Articles that are related to the one currently being viesved....
Articles Categories This module displays a list of categories from one parent category.

Articles Category This module displays a list of articles from one or more categories.

Availability Calendar search Display OF Calendar search farm

Banners The Banner Module displays the active Banners from the Component. CREATED NEW MODULE AND SELECT
MODULE TYPE: CUSTOM HTML

Breadcrumbs This Module displays the Breadcrumbs

Change template styles at Frontend Thiz module showes the slidebar st frortend and it allowes user to change the Frartend...

Custorm HTML Thizs Madule slliows vou to creste vour owen HTWL Madule Lsing s WSy G ecitar,

FavSlider Responsive Slideshow =p=Responsive Slideshow Module based on FlexSlider 2, the best respansive jGuery...
Feed Display Thiz module allovws the displaying of a syndicated feed
Footer Thiz module shows the Joomlal copyright information.

JM Slideshow Responsive Mo description available

To 'Edit' an existing Custom HTML module, in the Module Manager click on the Custom
HTML Module's Title or click the Custom HTML module's check box and then click the
Edit button in the Toolbar.



Sl -+ I

a# Module Manager: Module Custorn HTML Joormilal

B - covicks |+ saedbew || D Cancel @ Heip
Tl " Custom HTML
Moduda
Shew Tith
o o |
Hada
 site |
This Module allows: you to create your ows HTML Module esing a WYSPYG sditor Progition

Eda » Inser = View » Formal = Table = Towgls: =

B f UG FF AN Fuagaph =~ EE Ststus
EEN % & J 2 M« — @ |x x £ _

Start Publishing
=

Finish Publishing

AOCESS

Fuble -

1. Barnars -

=]

O aticie | & image & Togghe edior

Title: Module must have a title

Prepare Content: (Yes/No). Optionally prepare the content with the Joomla Content
Plug-ins.

Select a Background-Image: If you select an image here it will automatically be
inserted as an inline style for the wrapping div element

m e ACKkas || + SawiHew || O Cancs & Heip

T " | Custom HTML

Modus  Menu Assignment  Moduls Peemes sions Options  Advanced

oo e o

Select o Bachgroundimage | @ Select | M



Module Menu Assignment Module Permissions Advanced

Module Assignment |Oniy on the pages selected v|

Menu Selection: Select: Al None | Expand: Al None Search

@ ABOUT JOOMLA | -
Getting Started (Alias: getting-started)

@ [0 Using Joomlal (akss: using-oomia) | v
@ [ Using Extensions (Alias: extensions) |~
@ [ Components (Akas: components) |
© [F] Content Component (asas: content-component) | v
[£] Single Article (Alias: single-articie)

] Article Categories (Atas: article-categories)

B e R et T

@ USERMENU [ ~
Your Profile (Alas: your-profie)

Submit an Article (Alas: subme-an-article)

[T Submit a Web Link (Alas: submit-a-web-ink)

On this tab there is a list of menu items. You can choose between On All Pages, No
Pages, Only on the pages selected and on all pages except those selected from the
List.

If the latter two options are selected a list will show with all the menu items on as shown
in the screenshot above. This allows you to assign modules to some but not all pages,
and by selecting the menu links that you want the module associated with you can
customize on what pages modules appear/don't appear.

On above part, we have mentioned a bit in Custom HTML module in Joomla. Now, we
come back to Custom HTML modules of OSP Realestate template. All content of
custom HTML modules of template will be shown in bellow parts. But to create the
Custom HTML module with those HTML content, you must follow these steps:



1. Module Making Money

Making Money
Lorem ipsum dolor sit amet, consectetur adipisicing elit,
sed do elusmod tempor incididunt ut labore et dolore
magna aliqua. Ut enim ad minim veniam, quis nostrud

exercitation ullamco laboris nisi ...

Read More

Display front-end
Position: position-1
Custom HTML:
Click on Tools > Source code

Source code

<div id="post-104" class="homeland_semices type-homeland_senices status-publish
hentry services-list clear "><span class="hi-icon-wrap hi-icon-effect-1 hi-icon-effect-1a"> <i
class="hi-icon fa fa-tag"> </i= </span>

<div class="senices-desc">

<hi=Making Money</ha>

<p=Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ... </p>

<a class="more" href="#">Read More </a=</div>

</div>

HTML CODE:

www.joomdonation.com



2. Module Easy to Customize

Easy to Customize
Lorem ipsum dolor sit amet, consectetur adipisicing elit,
sed do elusmod tempor incididunt ut labore et dolore
magna aligua. Ut enim ad minim veniam, quis nostrud

exercitation ullamco laboris nisi ...

Read Mare

Position: position-2
Custom HTML:
Click on Tools > Source code

Source code

=div id="post-105" class="post-105 homeland_services type-homeland_senices status-
publish hentry services-list clear "><span class="hi-icon-wrap hi-icon-effect-1 hi-icon-
effect-1a"» <i class="hi-icon fa fa-cogs™> </i» </span=

=div class="senices-desc">

<h5=Easy to Customize</h5>

<p=Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ... </p=

<a class="more" href="#">Read More </a=</div>

<Idiv=

HTML CODE:

www.joomdonation.com



3. Module Moving Let Us Help

Moving Let Us Help

Lorem ipsum dolor sit amet, consectetur adipisicing elit,
sed do eiusmod tempor incididunt ut labore et dolore
magna aligua. Ut enim ad minim veniam, quis nostrud

exercitation ullamco laboris nisi ..

Position: position-3
Custom HTML:
Click on Tools > Source code

Source code

[kdiv id="post-106" class="posi-106 homeland_senices type-homeland_senices status-

publish hentry services-list clear last"=<span class="hi-icon-wrap hiscon-effect-1 hi-icon-
effect-1a"> <i class="hi-icon fa fa-armows-ali"> </i> </span>

<div class="services-desc">

<h5=Maving Let Us Help</h5=

<p=Lorem ipsum dolor sit amet, ipisicing elit, sed do ei d tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamce laboris nisi ... </p>

<a class="more" href="#">Read More </a></div>

</div=

HTML CODE:

www.joomdonation.com



4. Module Latest Bog

Latest Blog

QPARIS

Great deals on our anniversary

Posted by: Mark | December 10, 2013

Great deals on our anniversary

Posted by: Mark | December 10, 2013

Great deals on our anniversary

Posted by: Mark | December 10, 2013

Position: position-7
Custom HTML:
Click on Tools > Source code

Source code

fep=<img src="images/blog/caption-image2 jpg" alt=" /=</p>

<ul=

<liz

<div class="bimage col-xs-3 col-sm-3 col-md-3"><a href="#"> <img src="images/blog
Iblog1 jpg” alt=""f=</a»<idiv>

<div class="bdesc col-xs-9 col-sm-3 col-md-9">

<hb»<a href="#">Great deals on our anniversary</a=<fho>

Posted by: Mark | December 10, 2013</div>

<fliz

<liz

<div class="bimage col-xs-3 col-sm-3 col-md-3"><a href="#"> <img src="images/blog
Iblog2 jpg” alt=""f=</az<idiv>

<div class="bdesc col-xs-9 col-sm-3 col-md-9">

<hb»<a href="#">Great deals on our anniversary</a=<fho>

Posted by: Mark | December 10, 2013</div>

<fliz

i

<div class="bimage col-xs-3 col-sm-3 cal-md-3"><a href="#"> <img src="images/blog
Iblog1 jpg” alt=""/=</a»</div>

<div class="bdesc col-xs-9 col-sm-9 col-md-9">

<hb><a href="#">Great deals on our anniversary</a=<fh5>

Posted by: Mark | December 10, 2013 </div>

<fliz

<ul>

www.joomdonation.com



HTML CODE:

<p><img src="images/blog/caption-imagel2.jpg" alt="" /></p>

<ul>

<li>

<div class="bimage col-xs-3 col-sm-3 col-md-3"><a href="#"> <img
src="images/blog/blogl.jpg" alt="" /></a></div>

<div class="bdesc col-xs-9 col-sm-9 col-md-9'">
<h5><a href="#">Great deals on our anniversary</a></h5>
Posted by: Mark | December 10, 2013</div>

</1i>

<Ili>

<div class="bimage col-xs-3 col-sm-3 col-md-3"><a href="#"> <img
src="images/blog/blog2.jpg" alt="" /></a></div>

<div class="bdesc col-xs-9 col-sm-9 col-md-9">

<h5><a href="#">Great deals on our anniversary</a></h5>
Posted by: Mark | December 10, 2013</div>

</1i>

<li>

<div class="bimage col-xs-3 col-sm-3 col-md-3"><a href="#"> <img
src="images/blog/blogl.jpg" alt="" /></a></div>

<div class="bdesc col-xs-9 col-sm-9 col-md-9'">

<h5><a href="#">Great deals on our anniversary</a></h5>
Posted by: Mark | December 10, 2013</div>

</1i>

</ul>

5. Module Osp real estate

OSP REAL ESTATE

Position: footer-1
Custom HTML:
Click on Tools > Source code

HTML CODE:

<p>Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.</p>



% Module Manager: Module Custom HTML Joomlal
Source code

o e o
1 | <p=Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor F
= incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud

exercitation ullamco laboris nisi ut aliquip ex ea commedo consequat. </p>

Tile= | Osp real estate

Module Menu Assignment Module Permissions Options

Show Title

Custom HTML
Hide
This Module allows you to create your own HTML Module using a WYST Position

Edit~ Insert~ View~ Format~ Table~ Tools - [footer—1 * ']
B 7T U S|=% == Pragmph - = Status
EEbse|lsR@o|—m- %X (Q | Published

Lorem ipsum dolor sit amet, consectetur adipisicing €lit, sed do eiusmod tempar Start Publishing

aliquip ex ea commodo consequat.

.

Finish Publishing

-

Access

O[3 Cancel QOrdering

1. Osp real estate v

6. Module Address
ADDRESS

Position: footer-2
Custom HTML: Click on Tools > Source code

HTML CODE:

<div class="clear">108 Villa Precy Subdivision Kumintang Ilaya Batangas,
Philippines</div>

<div>Call us: +63(9012)45678</div>

<div><a href="mailto:info@site.com">info@site.com</a></div>



Source code

| + Save&Ciose || +Saves lew || mSaveaj

Title *

Address

Module | MenuAssignment  Medule Permissions  Options

Custom HTML

This Module allows you to create your own HTML Module using a WYSIWY(

Edit ~
|B 7 US == == |faagaph - [= E
=EElsc|s2@o|—m-|x X [0 |
108 Villa Precy Subdivisi lippir

Call us: +63(5012)45678
info@site.com

Insert ~ View~ Format -~ Table - Tools ~

Tiaya Batangas,

7. Module Links

Position; footer-3

|div class="clear"><i class="fa fa-map-marker fa-lg"> </i>108 Villa Precy Subdivision
Kumintang llaya Batangas, Philippines</div=

<div=<i class="fa fa-mobile fa-lg"> </i=Call us: +63(3012)45678</div=

<div><i class="fa fa-envelope-o fa-lg"> </i=<a
href="mailto:info@site.com">info@site.com=/a=</div=

Show Title

Pasition

[ footer-2

Status.
Publ

Start Publishing
‘ =]
Finish Publishing

\
Access
Ordering

- Cancel
.

Custom HTML: Click on Tools > Source code

Aodule Custom H

Joomilc

+ Save & Close || 4 Save&New || Dhsay
Tite* | Links |
Module | MenuAssignment  Module Permissions

Options

Custom HTML
[se=]

This Module allows you to create your own HTML Module using a WYSIW

Edit ~ Insert - View ~ Format ~  Table ~  Tools ~
(B 7 U 5 |= = = = [Poragraph - =
== |9 ¢ | L2 |—m@E-|x X (0 |
= Register
= Login

= Entries RSS
« WordPress'org

Source code *

<ul>

<liz<a href=
<li=<a href=
<liz<a href=
<li=<a href=
<li=<a href=
<ful>

"=Register</a=</li>

Log in</a></li>

Entries <abbr title="Really Simple Syndication”>RSS</abbr></a»</li>
Comments <abbr title="Really Simpie Syndication”>RSS</abbr></a></li>
"=\WordPress.org</a></li>

Show Title

Hide
Position
[ footer-3

<o)

Status
Published

Start Publishing

=

Finish Publishing

ACcess

Ordering
1. Links -

Ok Cancel




HTML CODE:

<ul>

<li><a href="#">Register</a></1i>

<li><a href="#">Log in</a></1li>

<li><a href="#">Entries <abbr title="Really Simple Syndication">RSS</abbr></a></l1i>
<li><a href="#">Comments <abbr title="Really Simple
Syndication">RSS</abbr></a></1i>

<li><a href="#">WordPress.org</a></1li>

</ul>

8. Module Banner

Badddie I

Our Services go beyond just providing safe, serene and beautiful exclusive house. As an

extended service, we also provide house packages that give you access to an array of
‘ house designs, suited to a variety of lot sizes and unique family need

s IS

Position: banner
Custom HTML: Click on Tools > Source code

-

w# Module Manager: Module Custom HTML

Source code
| v savesciose || +saveatiew || D

<div class="inside">

Title = l Banner <h2=Start a good life</h2=

<label>0ur Services go beyond just providing safe, serene and beautiful exclusive house.
As an extended service, we also provide house packages that give you access to an array
of house designs, suited to a variety of lot sizes and unique family need</label> <a
class="view-property” href="#"> View Properties </a></div=

‘ Mc\dule\ Menu Assignment Module Permissions Options

Custom HTML

This Module allows you to create your own HTML Module using a WYSIW

Edit~ Insert - View~ Format -~ Table - Tools ~

B I U s|s==s P - |EE

Start a good life

‘Our Services go beyond just providing safe, serene and beautiful exclusive hous
o a variety of lot sizes and unique family need View Properties

Cancel

HTML CODE:

<div class="inside">

<h2>Start a good life</h2>

<label>Our Services go beyond just providing safe, serene and beautiful exclusive
house. As an extended service, we also provide house packages that give you access
to an array of house designs, suited to a variety of lot sizes and unique family
need</label> <a class="view-property" href="#"> View Properties </a></div>



9. Header contact

. Call us: 1-800-234-6789

Position: head-contact
HTML CODE:

<p><span class="call-us"><i class="fa fa-phone"> </i> Call us: 1-800-234-6789
</span></p>

10. Module Mod_os_social

f v & in & @& N B

Position: head-social

%# Module Manager: Module mod_os_social Joomial

B Save « Save &Close | <+ Save&New || [N SaveasCopy || @ Close @ Help

Title* | Os social

Module Menu Assignment Medule Permissions Advanced
. Show Title
Os social
Show
Position
facebook # | head-social x v
) Status
twitter #
Published
google+ # Start Publishing
linkedin # _
Finish Publishing
youtube #
pinterest # Access
Publi
dribbble # Co
Ordering
feedburner # | 1. 0s social
instagram # Language

11. Footer (Copyright module) (Joomla core module)

Copyright © 2014 osp-realestate. All Rights Reserved.

Position: Footer

www.joomdonation.com



Troubleshooting

JavasScript Errors

Nowadays almost every Joomla extension uses JavaScript to create a more
responsive website for a better user experience. Mostly all JavaScript's rely on a
JavaScript library like jQuery, Mootools or others. Using different scripts on a webpage
can cause conflicts between them. This tutorial helps you to detect and resolve these
script errors.

How to detect errors?

If your website does not work as you expect when you click something or an
animation stopped working, this could be the result of a script error. In case of an error
the script-execution will be stopped by the browser. While some pages might still work,
others don't. Not every script is being loaded on every single page of your website. A
way to investigate these errors is to use the browser's debug console on the page
where the error occurs. In Firefox you can use the Firebug Add-on, other browsers like
Chrome, Safari or Opera already have similar tools built-in. These developer tools will
show you the script-errors including information about what went wrong, the file and
line number, and the line of source code that caused the error. This will really help you
with debugging any script errors.

How to resolve errors?

If you've detected a JavaScript error on a page you need to find its origin. Usually the
errors are caused by an extension or combination of multiple extensions. The browser's
debug console will help you to identify the scripts and their related files on your
webserver. Once you have identified the extension you can fry disabling it to make
sure your page works without any errors again. If the error is gone, you've found the
extension causing the conflict. Now you can look for the extensions configuration
option and see if it lets you enable/disable loading a JavaScript library like jQuery to
resolve the errors.

How to prevent loading jQuery multiple times?

There is an ongoing discussion in the Joomla community on how to prevent loading
jQuery multiple times across extensions. We have already taken steps and measures
by implementing a widely accepted solution. We register through JApplication
whether jQuery is loaded or not. In case a 3rd party extension loads the jQuery library
you can use the following code snippet to prevent our OS Property extension, theme
from loading it twice:

// load jQuery, if not loaded before

if (!JFactory::getApplication()->get ('jquery')) {
JFactory: :getApplication () ->set ('jquery', true);;
// add jQuery



Useful Links

« Firebug Guide for Web Designers - http://sixrevisions.com/tools/firebug-guide-web-
designers

e Chrome Developer Tools - http://code.google.com/chrome/devtools/

e HTML5 Rocks - Introduction to Chrome Developer Tools -
http://www.html5rocks.com/en/tutorials/developertools/part1/

o PaulIrish - A Re-introduction to the Chrome Developer Tools -
http://paulirish.com/2011/a-re-infroduction-to-the-chrome-developer-tools/

« Safari Developer Tools -
http://developer.apple.com/library/safari/#documentation/appleapplications/Conce
ptual/Safari_Developer_Guide/DebuggingYourWebsite/DebuggingYourWebsite.html

e Opera Developer Tools - http://www.opera.com/developer/tools/
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Recommendation

The above user guide should help one in replicating the Demo site settings for the
template and extension on their site.

Recommended :

If you are new or are confused, we recommend installing Quickstart on your localhost
and use it as reference for the configurations. This is the best way to work with any
template. Links to all the resources are provided above. We suggest you to carefully
go over those in order to take the maximum advantage of our products.

Support :

Please raise your support queries in the forum and make sure you follow the support
guidelines. We would need to spend more time to get back to you, in case the
support guidelines are not followed.
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